
VI-5.1 

Using E-Mail in 
Outlook 
After completing this lesson, you will be able to: 

� Compose, address, and send messages. 

� Format the body of a message. 

� Attach a file to a message. 

� Check for e-mail messages. 

� Read messages. 

� Reply to and forward messages. 

� Print messages. 

� Find messages. 

� Recall messages. 

� Delete messages. 

� Save a draft of a message. 

Gone are the days when the telephone was the main way to communicate with 

other people immediately and postal mail was the chief way to send letters and 

documents to others. Today, e-mail enables you to communicate and share 

information with others in a way that is faster and more versatile than methods 

that were available in the past. E-mail refers to any communication that is sent 

or received via computers, either over the Internet or through a messaging 

program used with an organization’s internal network, or intranet. 

Creating, sending, receiving, and reading e-mail messages are the activities that 

you will probably perform most frequently with Microsoft Outlook. E-mail 

provides a fast way to send and receive messages, files, and documents such as 

reports, worksheets, and pictures. 

In this lesson, you will learn how to create, address, format, and send an e-mail 

message. You will learn how to attach a file; check for and read messages; and 

reply to and forward messages you receive. You will learn how to flag 

messages with a reminder to yourself or to the recipient to follow up on the 

message by a certain date. You will also learn how to print, find, and recall 

messages that you’ve sent. You will learn how to save e-mail messages that 

you aren’t ready to send in Drafts, a folder that stores incomplete messages. 

Finally, you will learn how to delete messages.  

To complete the exercises in this lesson, you will need to use the files named 

Map and Syllabus in the Computer Fundamentals Practice folder that is located 

on your hard disk. 

LESSON 5 

Your Outlook folders should 

already contain the Outlook 

items (e-mail messages and 

contact records) that are 

necessary to complete the 

exercises in this lesson. 
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important 

To complete some of the exercises in this lesson, you will need to 

exchange e-mail messages with a class partner. If you don’t have a class 

partner or you are performing the exercises alone, you can send the 

message to yourself. Simply enter your own e-mail address instead of a 

class partner’s address. 

Composing, Addressing, and Sending 
Messages 

If you’ve used other e-mail programs, you’ll probably find that creating and 

sending messages is similar in Outlook. To create a new mail message, click 

the New button when you are in the Inbox folder. You can create a new e-mail 

message from any folder. Point to New on the File menu and click Mail 

Message to display a new message window. 

The message you create can be any length and contain any information. The 

following illustration displays the window used to create an e-mail message. 

 

Just as you must address an envelope before mailing it, you must also provide 

at least one e-mail address in the To box of your message. E-mail can be 

addressed to any number of recipients and the message is sent to all recipients 

simultaneously. To send a message to multiple recipients, type a semicolon 

after each recipient’s e-mail address in the To box. After you type one or more 

e-mail addresses, enter the subject of your message, type the message, and click 

the Send button to send the message. Typically, your e-mail message arrives in 

the recipient’s Inbox within seconds after you send it. 
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Outlook has made it easy for you to address an e-mail message if you have sent 

a message to the same recipient before or the recipient’s e-mail address is 

stored in Outlook’s address book. The AutoComplete addressing function 

automatically completes the address as you start to type it. If the address 

Outlook suggests is correct, press the Tab key to enter the complete address. If 

Outlook finds several matches, it presents a list of possible matches. Use the 

arrow keys to select the correct entry and press the Enter key.  

Internet E-mail Accounts 

Microsoft Outlook 2002 supports several types of Internet e-mail accounts. 

Account types include POP3, IMAP, and HTTP.  

• Post Office Protocol 3 (POP3)—Common type of e-mail account 

provided by an ISP (Internet Service Provider). To receive 

messages, you connect to an e-mail server and download messages 

to your local computer. 

• Internet Message Access Protocol (IMAP)—Messages are stored on 

the e-mail server. When you connect to an e-mail server, you read 

the headers and select the messages to download to your local 

computer. 

• Hypertext Transfer Protocol (HTTP)—Messages are stored, 

retrieved, and displayed as Web pages. MSN Hotmail, a free, Web-

based e-mail service offered by Microsoft, provides HTTP accounts. 

Below the To button is the Cc button. Cc is an acronym for carbon copy, 

referring to the days of printed letters when copies were made by using carbon 

paper. The copy contains the same content sent to the recipient identified in the 

To box. However, a copy of a message is sent to others for information 

purposes only; the Cc recipients are not required to take any action.  

The Cc function is optional: You can send a message without sending any 

copies. However, there are times when it is valuable to be able to copy a 

message to others. To send a copy, simply enter the individual’s e-mail address 

in the Cc box. To send a copy to multiple recipients, type a semicolon after 

each recipient’s e-mail address. When the Cc recipient receives the message, 

his or her address appears in the message header as a Cc. 

The subject of the message is usually a brief description of the information in 

the message. All of the message recipients will see the message header when 

the message arrives in their Inboxes. A message header includes the name of 

the sender, the subject of the message, and the date and time when the message 

was sent. This information enables recipients to quickly identify the purpose of 

the e-mail without opening the message. If you don’t type a subject for a mes-

sage, Outlook warns you that the message has no subject before you send it.  
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important 

Although you clicked the Send button, the message has not necessarily 

been sent over the Internet (or over the intranet) yet. By default, Outlook 

connects to your server (Workgroup, Corporate, or Internet service 

provider) to send and receive e-mail every 10 minutes. Messages that have 

been sent but have not yet made it to the server are stored in your Outbox, 

a folder whose shortcut is found in the My Shortcuts group on the Outlook 

bar. To send and receive e-mail immediately, click the Send/Receive 

button. This action connects your computer to your server, sends all e-mail 

messages in the Outbox, and retrieves any messages that the server has 

for you. To avoid delays while performing the exercises in this book, click 

the Send/Receive button immediately after you click the Send button. 

Formatting a Message 

Looks aren’t everything, but a message that looks good makes a positive 

impact on the recipient. Outlook 2002 uses Microsoft Word as the default  

e-mail editor, placing the power of Word’s formatting options at your 

fingertips. A few clicks of the mouse can apply formatting that highlights 

important information or gives your message a bit of flash to make it stand out 

in the crowd of messages that fill many Inboxes.  

The Formatting toolbar is familiar if you use Microsoft Word. It enables you to 

apply formats that create the image you want to present. Color the name of 

your product. Make the dates of a conference bold so recipients can see them at 

a glance. Highlight the important numbers in a sales report. Make your point 

with a bulleted list. Your options are endless. 

 

Applying formats is easy. Type the body of the e-mail message in the message 

area. Select the text you want to format. Click the appropriate button on the 

Formatting toolbar. The selected text immediately takes the new format. 

You can include a Web site address in an e-mail message. When a recipient 

clicks the Web address, it automatically starts the default Web browser and 

displays the Web site. Including a Web site address in the message is helpful 

because the recipient does not need to leave the message to open a Web 

browser and type the Web site address to access the site. To include a Web site 

address in a message, just type it in the message. Outlook automatically formats 

the address (or URL, an acronym for Uniform Resource Locator) as a link to a 

Web page—for example, www.microsoft.com. 
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Flagging Messages 

Sometimes it’s necessary to remind yourself or notify recipients of the 

importance of a message that you are sending. Perhaps you sent a message 

about an event with a specific deadline or asked for input on a particular topic. 

You can flag the message to remind yourself to follow up on an issue or you 

can flag an outgoing message with a request for someone else to follow up with 

a reply. 

When you create a new message, click the Flag For Follow Up button on the 

Message toolbar in the message window. A dialog box is displayed that enables 

you to identify the reason you flagged the message, such as requesting a reply, 

requesting follow-up action, and stating that no response is necessary. You also 

can set the due date for the follow-up action. When a recipient receives a 

message with a flag, the purpose of the flag is displayed at the top of the 

message. If a date was set, that date appears as well. 

The message appears in the recipient’s Inbox with either a red flag, indicating 

that action still needs to be taken, or a gray flag, indicating that the request is 

complete. 

In this exercise, you compose a message and send it to your class partner. 

1 When you are in the Inbox folder, click the New Mail Message 

button on the Standard toolbar. 

A message window is displayed. 

2 In the To box, type the e-mail address of your class partner or type 

your e-mail address if you are working alone. 

3 Press Tab twice. 

The insertion point moves to the Subject box. 

4 Type Picnic Reminder and press Enter. 

The subject is entered and the insertion point moves to the 

message area. 

5 Type Just a reminder that our 5th annual Fun in the Sun picnic 

is on Saturday, June 6th. 

Your message window contains all the necessary information. 
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6 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to the recipient. 

Attaching a File to a Message 

In today’s fast-paced workplaces, you need to be able to get information to 

several people in a short amount of time. As an example, the sales manager at 

Adventure Works, an outdoor vacation resort, likes to distribute Microsoft 

Excel sales forecast workbooks to other managers at the resort. Rather than 

distributing printed copies or retyping the contents of these documents into  

an e-mail message, the sales manager can make the workbook file an 

attachment—an external document included as part of a message—and send 

the message and the attachment to all recipients at one time. 

An attachment can be a file, a document stored on a disk, or another Outlook 

item. A file can be any type of document, such as a Microsoft Word document, 

an Excel spreadsheet, or a picture. An item is an Outlook object, such as a 

contact, task, or note. You will learn how to create and use these and other 

Outlook items later in this course. 

The selected attachment appears in a new field, the Attach box, located below 

the Subject box. The attachment is displayed as an icon, or graphic 

representation of the attached file. The name and size of the file are also 

displayed. When you send the message, the message recipient can double-click 

the icon to open and view the file or item. 

To attach a file to a message, compose the message just as you normally would 

and click the Insert File button on the Message toolbar in the message window. 

Your To box will contain your 

class partner’s e-mail 

address. 

If the server is down or if 

there is a problem with the 

connection to the Internet, 

messages are placed in the 

Outbox until a connection is 

established. 

The appearance of the icon 

depends on the file type of 

the attachment. For example, 

the icon for an attached Word 

file is the same icon that 

represents Word files in 

Windows Explorer. The icon 

for an attached Excel file is 

the same icon that represents 

Excel files in Windows 

Explorer. 
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Navigate to the folder that contains the file, click the file name, and click the 

Insert button. Repeat this procedure to attach multiple files to a message. 

To attach an Outlook item to a message, click the down arrow next to the Insert 

Item button on the Message toolbar. Select Item to display the Insert Item 

dialog box. In the Look In list, click the folder name for the type of Outlook 

item, such as a contact, that you want to attach. In the Items list in the bottom 

pane, click the item that you want to attach and click OK. The icon representing 

the attached Outlook item is displayed in the Attach box. 

Setting Message Priority 

You can also specify the priority for a message. When you mark a message as 

High priority, the message header appears in the recipient’s Inbox with a red 

exclamation point, indicating that you want the recipient to reply to or read the 

message as soon as possible. When you mark a message as Low priority, a 

blue, downward-pointing arrow appears in the message header, indicating that 

the recipient can reply to or read the message when convenient. 

To mark a message as High or Low priority: 

• On the Standard toolbar in the message window, click the 

Importance: High button (indicated by a red exclamation point). 

or 

• On the Standard toolbar in the message window, click the 

Importance: Low button (indicated by a blue down arrow). 

In this exercise, you compose a message, attach a picture to the message, and 

send the message and file attachment to the recipient. 

1 On the Standard toolbar, click the New Mail Message button. 

A message window is displayed. 

2 In the To box, type the e-mail address of the recipient. 

3 Press Tab twice and type Fun in the Sun Picnic Invitation in the 

Subject box. 

4 Press Enter. In the message area, type Hope to see you at the 

picnic on June 6th at 1:00 P.M. For directions to Cherry Creek 

Park, please see the attached map. See you there! 

5 On the Message toolbar in the message window, click the Insert 

File button. 

The Insert File dialog box is displayed. 

6 Click the Look In down arrow, navigate to the Unlimited Potential 

folder on your hard disk, and then double-click on the folder. 

7 Double-click the Computer Fundamentals Practice folder.  

8 Double-click on the Part VI folder, then the Lesson05 folder. 
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9 Double-click the Map file to attach it to your e-mail message. 

Outlook attaches the Map file to the e-mail message and the Insert 

File dialog box closes. Your screen should look similar to the 

following. 

 

10 On the Message toolbar in the message window, click the Send 

button. 

The message is sent to the recipient. 

If you send an e-mail 

attachment to someone who 

connects to the Internet using 

a slow modem (33.6 KBps or 

slower), you should limit the 

attachment size to 300 KB or 

less. Messages with large 

attachments can take a long 

time for the recipient’s e-mail 

program to receive. 
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Checking for E-Mail Messages 

Just as Outlook sends e-mail every 10 minutes, Outlook automatically checks 

for new mail every 10 minutes. Later in this course, you will learn how to 

change this setting to a longer or shorter interval. You can manually check for 

messages at any time. Simply click the Send/Receive button on the Standard 

toolbar. Any messages that are on the mail server appear in your Inbox. 

important 

Interoffice mail—e-mail sent over a local area network (LAN) or to a 

Microsoft Exchange Server post office—is usually sent almost 

instantaneously. However, when you send e-mail to someone outside of 

your LAN or Exchange Server, you send the message over the Internet. 

Your Internet service provider’s mail server places incoming messages in a 

mail queue. The mail queue is a list of messages received by a mail server 

organized in the order in which the messages are received. In turn, 

messages are sent to recipients in the order in which the server received 

them. Sometimes, this means you have to wait a few minutes to receive an 

Internet mail message that was sent to you. 

In this exercise, you check for incoming e-mail messages. 

1 If necessary, click the Outlook Shortcuts group bar on the Outlook 

bar and click the Inbox shortcut. 

The contents of the Inbox folder are displayed. Message headers 

are displayed in the top pane of the message window for messages 

that you’ve already received. 
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2 On the Standard toolbar, click the Send/Receive button. 

A progress bar indicating that Outlook is sending and receiving 

messages is displayed briefly before new message headers appear 

in the top pane of the message window. The messages were 

created and sent in previous exercises by you or your class partner. 

Reading Messages 

By default, the Preview pane is displayed when you open the Inbox folder. The 

Preview pane is located below the Inbox. To read the body of a message in the 

Preview pane, click the message header in the Inbox. Messages that you have 

read are shown with an open envelope icon to the left of the message header; 

unread messages appear with a closed envelope icon. If the Preview pane is not 

displayed, double-click a message header to open the message in a separate 

window. 

The Preview feature has been improved in Outlook 2002. Select AutoPreview 

on the View menu. Up to three lines of each message is displayed in the Inbox 

directly below the message header. This enables you to scan for important 

messages and read a message without opening it in a separate window. 

AutoPreview is useful if you receive dozens of e-mail messages each day and 

want to scan through them quickly to determine which messages to read first. 

You can quickly spot junk e-mail messages that have deceptive headers. 

The Preview pane displays the complete message header and provides a 

scrollbar to view the entire message. You can also open an attachment in the 

Preview pane. In the top-right corner of the Preview pane, click the paper clip 

icon, and click the attachment. 

The AutoPreview and Preview pane menu commands are on/off toggles. That 

is, if you click one of these commands while the feature is turned on, the 

feature is turned off. If you click one of these commands while the feature is 

turned off, the feature is turned on. Select AutoPreview or Preview pane on the 

View menu to toggle each feature. 

If you are using Exchange 

Server to send and receive  

e-mail messages, or if you 

have multiple e-mail 

accounts, point to 

Send/Receive on the Tools 

menu and click the account 

that you want to send to and 

receive from. 
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In this exercise, you read the e-mail messages that your class partner sent to 

you. 

1 Click the Fun in the Sun message header. 

The message is displayed in the Preview pane. 

2 Double-click the Fun in the Sun Picnic Invitation message header. 

The message is displayed in a separate window. Notice the 

attachment icon in the message. 

3 Double-click the Map attachment icon in the message window. 

The map is displayed in a separate window by the application your 

computer uses to view graphics. 

4 In the top-right corner of the window that contains the map, click the 

Close button. 

The application closes. 

5 In the top-right corner of the message window, click the Close 

button. 

The message closes. 

Replying to and Forwarding Messages 

If you receive an advertisement via postal mail, you might read it or discard it. 

If you receive a letter from a friend sent via postal mail, you might respond by 

writing and sending a reply to your friend. 

E-mail is similar. Sometimes, you’ll read an e-mail message without replying 

to the message. At other times, you’ll reply to e-mail messages sent by friends 

or coworkers. A reply sends a copy of the original message and additional text 

that you type, if any. The recipient sees the text RE: and the original subject in 

the message header. When you reply to a message, your response is 

Be sure to single-click the 

Picnic Reminder message in 

step 1. Double-clicking the 

message has a different 

result. 

You can also open the 

attachment from the Preview 

pane. In the message 

header, click the icon that 

represents the attachment. 
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automatically addressed to the sender. If the original message was sent to you 

and several other recipients, you can choose to reply to the sender and all the 

other recipients. 

After you receive an e-mail message, you might decide that the information 

contained in the message will be useful to others. If so, you can forward the 

message to other recipients. Forwarding a message lets you send a message to 

individuals who were not originally on the recipient list. Simply click the 

Forward button on the Standard toolbar in the Inbox folder, type the e-mail 

addresses of the additional recipients in the To box, and click the Send button. 

You can also type additional information at the beginning of the forwarded 

message before you send it. 

In this exercise, you reply to the message that you receive and forward the 

message to another individual. 

1 In the Inbox, verify that the Fun in the Sun Picnic Invitation 

message header is selected. 

2 On the Standard toolbar, click the Reply button. 

A reply window containing the original message is displayed. The 

insertion point is already in the message area. 

3 In the message area, type Yes, I will attend the picnic. 

4 On the Standard toolbar in the message window, click the Send 

button. 

The reply is sent to your class partner. 

5 On the Standard toolbar, click the Send/Receive button. 

A reply from your class partner arrives in the Inbox. 

6 In the Inbox, click the Fun in the Sun Picnic Invitation message 

header again. 

7 Click the Forward button on the toolbar. 

A forward window opens with the original message displayed. 

8 In the To box, type an e-mail address for a class member other 

than your class partner. 

9 On the Standard toolbar in the message window, click the Send 

button. 

The message is forwarded to a class member. 

10 On the Standard toolbar, click the Send/Receive button. 

A forwarded message from a class member arrives in the Inbox. 

tip 

You can also reply to or forward a message by clicking Reply or Forward on 

the Actions menu. 

You need the e-mail address 

of someone in your class 

other than your class partner 

to complete this exercise. If 

another e-mail address isn’t 

available, use your own 

address. Replies and 

forwarded messages will be 

sent to your address. 

When you forward a 

message you can add new 

text in the message area 

before you send it. 
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Printing Messages 

It’s often convenient to print a copy of a message so you can read the message 

when you’re not at your computer or you can give the printed message to 

somebody who does not have access to e-mail. For example, Adventure Works 

employees found it useful to print a copy of a message that provided directions 

to the company picnic so they could follow the directions to get to the park. 

You can also print message attachments if the application used to create the 

attachment is installed on your computer. You can print an attachment by 

opening the attachment and using the Print command of the program that opens 

the attachment. You can also right-click the attachment icon in the message 

window and click Print on the shortcut menu. The attachment is printed by the 

default printer for your computer.  

Outlook includes several options for printing e-mail messages when you are in 

the Inbox folder. Messages can be printed in Table style or Memo style. If you 

print using the Table style, the document contains a list of messages in a table 

format that resembles the Inbox; the message headers that are currently in your 

Inbox are listed under column headings, such as From, Subject, and Received. 

If you print using the Memo style, the document contains your name at the top 

of the page, information about the message (who the message was from, when 

the message was sent, who the message was sent to, and the subject of the 

message); the actual message is printed last. 

Select Page Setup on the File menu to open the Page Setup dialog box. This 

enables you to preview the page style, the size of the columns and rows (if you 

selected the Table style), and the fonts in which the message will be printed. 

Click the Paper tab in the Print Setup dialog box to change the paper type and 

select a page style. Paper options include letter, legal, and A4. Page styles 

include the Day-Timer and Franklin Day Planner styles. 

In this exercise, you print an e-mail message in the Memo style and set up 

Outlook to print an e-mail message and its attachment. 

1 In the Inbox, click the Picnic Reminder message header. 

The Picnic Reminder message header is selected. 

2 On the Standard toolbar, click the Print button. 

One copy of the e-mail message is printed. 

3 Click the original Fun in the Sun Picnic Invitation message header. 

4 On the File menu, click Print. 

The Print dialog box is displayed. The options in the dialog box will 

be different if you choose Table Style. 

When printing an attachment, 

Outlook might display an alert 

box warning you of the 

possible danger of viruses 

hidden within attached 

messages. Click the Print 

button in the message box to 

continue the printing process.  
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5 In the Print Options section of the dialog box, select the Print 

Attached Files With Item(s) check box, and click OK. 

Outlook prints the e-mail message in the Memo style and prints the 

attachment. 

Finding Messages 

If you send and receive a lot of messages on a regular basis, your Inbox and 

Sent Items folder might contain dozens or even hundreds of messages. At 

some point, you might need to track down a specific message sent to a recipient 

or a message received from a particular e-mail address. For example, one of the 

new employees at Adventure Works said he didn’t receive directions to the 

picnic. The sender opened the Sent Items folder and searched for a key word or 

phrase (such as picnic directions) that she knew was contained in the message. 

She forwarded the message to the employee who had not received the 

directions. 

In this exercise, you find the messages that contain the word directions. 

1 On the Standard toolbar, click the Find button. 

The Find Items In Inbox pane is displayed. 

2 In the Look For box, type directions. 

3 Select the location to be searched. 

4 Click the Find Now button. 

The results are displayed. The messages containing directions 

should be the only messages listed. 
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5 Click the Close button in the Find Items pane. 

The pane closes. 

Recalling Messages 

If you are connected to a network that uses Microsoft Exchange Server, you 

can recall a message and send an updated message. Use this feature to reissue 

information that might have been sent incorrectly the first time or to retrieve 

messages sent to the wrong recipient. For example, the recreation director at 

Adventure Works sent a message to the planning team announcing an 

upcoming event and accidentally typed the wrong date for the event. He 

recalled the message, made the correction to the date, and sent the corrected 

message.  

To be recalled, a message must meet four criteria. The recipient must be logged 

on to the network. The recipient must use Microsoft Outlook. The message 

must be in the recipient’s Inbox. The message must be unread. 

To recall a message, take these steps:  

1 Open the Sent Items folder.  

2 Double-click the message to be recalled.  

3 Click Recall This Message on the Actions menu.  

4 Choose to delete the unread messages or delete the unread 

messages and send a replacement message.  

5 Click OK to recall the message. 
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Deleting Messages 

After reading new messages, you can leave them in the Inbox. However, you 

will find that over time your Inbox can become cluttered if you don’t organize 

or remove messages regularly. You can choose to delete any outdated e-mail 

messages by clicking the message header and then clicking the Delete button 

on the Standard toolbar or pressing the Delete key. 

When you delete messages, they are not permanently removed from Outlook. 

Instead, they are placed in the Deleted Items folder until you decide to empty 

it. This safeguard makes it possible to restore your messages if you accidentally 

delete them or realize that you still need certain deleted messages. 

In this exercise, you delete a message from the Inbox and empty the Deleted 

Items folder. 

1 In the Inbox, click the Picnic Reminder message header. 

2 On the Standard toolbar, click the Delete button. 

The message moves to the Deleted Items folder. 

3 In the Folder List, click Deleted Items. 

The Deleted Items folder opens, displaying the message that you 

deleted. 

4 Click the message. 

The message is selected. 

5 Press Delete. 

An alert box asks you to confirm the deletion. 

6 Click Yes. 

The items are removed from the Deleted Items folder and 

permanently deleted. 

Saving Drafts 

If you are interrupted while composing a message, you can save it in your 

Drafts folder. You can complete and send the message later. You can create a 

draft of a message in two ways: 

■ In the top-right corner of the message window, click the Close 

button. Outlook will ask if you want to save the message. Click Yes 

to save the message without sending it. 

or 

■ On the Standard toolbar in the message window, click the Save 

button and click the Close button in the top-right corner of the 

message window. 

To select multiple message 

headers that are displayed 

together, click the first 

message header, hold down 

the Shift key, and click the 

last message header. To 

select multiple message 

headers that are not 

displayed together, click the 

first message header, hold 

down the Ctrl key, and click 

each additional message 

header. 

To restore a deleted 

message, drag the message 

from the Deleted Items folder 

to the Inbox shortcut on the 

Outlook bar. 

You can also delete all 

messages in the Deleted 

Items folder by clicking 

Empty “Deleted Items” Folder 

on the Tools menu. 
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To retrieve a draft so that you can complete the message and send it: 

1 Display the Folder List and click the Drafts folder. 

2 Double-click the message to open it. 

3 Complete or edit the message and send it just as you normally 

would. 

Lesson Wrap-Up 

This lesson introduced you to some of the capabilities of Outlook e-mail, 

including composing, saving, and sending e-mail. You learned how to read a 

message and how to reply to and forward messages. You also learned how to 

include an attachment in an e-mail message, find a message, delete a message, 

and move items between two folders. 

If you are continuing to the next lesson: 

■ In the top-right corner of the Folder List, click the Close button. 

The Folder list closes. 

If you are not continuing to other lessons: 

■ In the top-right corner of the Folder List, click the Close button. 

The Folder list closes. 

Quick Quiz 

1 How do you manually check for messages in Outlook without 

waiting for messages to be sent or received at the preset interval? 

2 What are the steps you take to create an e-mail message? 

3 What happens to a message when you delete it from your Inbox? 

4 What information is contained in the header of a message? 

5 How do you read an e-mail message? 

6 How do you save a message without sending it so that you can 

complete or edit the message later? 

7 What is the Inbox? 

8 What can you insert into an Outlook e-mail message? 

9 What is the value of AutoPreview? 



VI-5.18 Computer Fundamentals 

Putting It All Together 

Exercise 1: The training director at Adventure Works must send an Outlook 

class announcement to those who signed up for the class. The date, time, and 

location of the class should be included in the message. Use the date, time, and 

location for your Outlook class to provide this information. A syllabus for the 

class must be sent as an attachment. You can find the syllabus in the Part VI, 

Lesson05 folder in the Computer Fundamentals Practice folder on your hard 

disk. 

Send the class announcement with the syllabus—and include a flag—to your 

partner, to another member of your class, and to yourself. When you receive the 

message, print the syllabus. 

Exercise 2: After you sent the class announcement, you discovered that the 

location of the class has changed. Notify the recipients that the location of the 

class has changed. After you’ve completed this task, delete the message. 

Exercise 3: Create a message describing the benefits of using Outlook. Use 

the Formatting toolbar to create visual interest. Set a flag to request a reply in 

10 days. Send the message. 

Exercise 4: Move the messages you sent about the picnic from the Sent Items 

folder to the Deleted Items folder. Delete the messages. 

Exercise 5: A coworker complains that it takes several minutes for his mail 

messages to be sent and he frequently experiences a delay in receiving 

messages. Use Microsoft Outlook Help to explain the delay in sending and 

receiving mail. Describe how he can fix the problem. 


